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O b j e c t i v e s  

Upon completion of this course, you will be able to: 

• Describe the Sabre® global distribution system equipment and keyboard 

• Sign in and out of the Sabre system 

• Change to a different work area 

• Place text in the Memo Area 

 

I n t r o d u c t i o n  t o  t h e  S a b r e  S y s t e m  

Welcome to the Sabre system! 

The Sabre system has consistently been rated the number one Global Distribution 
System (GDS) in the world and continues to maintain a leadership position in 
bookings share. You now have at your fingertips a host of technology solutions that 
will serve as your gateway to a wide variety of travel and travel-related services. 

 
Whether you’re in transition from proficiency with another Global Distribution 
System to the Sabre system or are new to the travel industry, we want to help you 
gain a working knowledge and understanding of the Sabre system as quickly as 
possible. It is not important to remember all the formats. Memorization of formats 
will come with time. However, it is important for you to know where to locate the 
answers to your questions and to feel confident in planning your continued training. 

Learning 
about the 
system 

This session provides information to familiarize you with terminology and concepts 
of the agency environment as they pertain to the Sabre system. It will also provide 
the tools necessary to service your client in a professional and timely manner, which 
will be profitable and beneficial to your client, you, and your agency. 

 
If known, record your agent sign and agency pseudo city code below for reference. Your 

information Agent sign:  ___________ 

Agency Pseudo City Code (PCC):  _____________ 
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E q u i p m e n t  a n d  K e y b o a r d  

The Sabre system workstation consists of three main components: 

• Monitor (screen) 

• Base unit or central processing unit (CPU) 

• Keyboard 

Your system workstation is also referred to as a PC or PC Terminal. Additional 
equipment associated with your workstation may include a mouse, printer, and 
cabling. 

 
The following diagram represents the Sabre system keyboard. Diagram of 

keyboard 
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The cursor is a blinking character on the Sabre system screen that indicates 
placement of the next character to be typed. The cursor automatically returns to the 
left margin after every entry. 

Definition of 
Cursor 

 
The table below describes the main components of the Sabre system keyboard. Parts of the 

keyboard 
Component Function 

PF keys Also called function keys. Used to program and store formats that are 
used repeatedly. 

Main keyboard Number and letter keys used for most typing and entry functions. 

Miscellaneous 
keys 

Used to insert and delete information, reenter, reset cursor to top left 
margin of screen, and place text in the upper portion of the screen. 

Arrow keys Used to move the cursor up, down, left, and right on the screen. 

Numeric key pad Functions as a calculator. 

Alt key Performs a function if depressed in conjunction with another key. 

Ctrl key Performs a function if depressed in conjunction with another key or keys. 
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Keyboards designed for Sabre workstations have some keys with special labels 
and/or symbols not found on other keyboards. Agents use these symbols, combined 
with letters and numbers, to perform specific functions in the Sabre system. 

Identification 
Code Keys 

Some of the keys labeled for particular functions allow you to create or display a 
Passenger Name Record (PNR). These are known as Identification Code Keys (ICK). 
The keys are labeled with codes to identify their functions. Below is an illustration 
and explanation of the Identification Code Keys. 

1
AVAIL

2
FLIFO

3
GFAX

4
FAX

5
RMKS

6
RCVD

7
TKT

8
  TL

9
FONE

0
SEG

-
NAME

*
DSPLY

 

Code Label Description 

1 AVAIL Request city pair availability, which is used to determine whether 
seats are available on a flight 

2 FLIFO Request flight Information 

3 GFAX Request special services or send information about the passenger’s 
inflight needs to all airlines except American 

4 FAX Request special services or send information about the passenger’s 
inflight needs to American Airlines 

5 RMKS Add remarks about the client or the reservation 

6 RCVD Add “received from” for the booking (the person from whom the 
reservation request was received) 

7 TKT Add ticketing arrangements 

8 TL Add time limit for ticketing (automatically cancels the reservation if no 
ticket is issued by the specified time/date) 

9 FONE Add telephone number for the agency and/or passenger 

0 SEG Sell reservations for air, car, hotel, etc. 

- NAME Add passenger name 

* DSPLY Display Passenger Name Record (PNR) or other information, when 
used in combination with other characters 
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These additional keys are used to identify specific functions in the system. Other keys 
with special 
functions System Key Function 

{  [
[

 

Change 

Used in conjunction with system entries to change, delete or calculate 
information. 
Note: The symbol used in printed material to illustrate this keystroke is 

⌧. 

 

End-Item 

Used to string several entries together and enter them simultaneously. 
Note: The symbols used in printed documents to illustrate this key are 

&  or  ∑. 

"  ;
' =

 

Cross of 
Lorraine 

Used as a plus sign and to separate parts of an entry that combines 
related functions, i.e., Pricing, ticketing, and invoicing. Located to the 
left of the Enter key. When pressed, the symbol appears on the screen. 
Note: The symbol used to illustrate this keystroke is ‡. 

 

Here’s one quick example of an entry that uses the Cross of Lorraine key. 

 
Each workstation has its own specific terminal address, also known as a LNIATA. 
To display your workstation’s terminal address, enter: 

Terminal 
address 

Format:  ‡J 

Response: YOUR SET ADDRESS IS  68372A  P-23  LS05 RESD 
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Specific keys allow you to transmit information to the system, reposition your cursor, 
and even clear your screen. The location of these keys may be different on the 
keyboards in your office, but the functions of the keys are the same. 

Keys to enter, 
clear, and 
reposition 
the cursor 

System Key Function 

Backspace
Clear

 

Clear 

Used to clear the screen without canceling or changing any of the data 
previously entered. The cursor is returned to the upper left corner of the 
screen. The default of this key may be changed to become the 
backspace key. 

Print-Enter
Enter

 

Print-Enter/Enter 

Used to transmit items to the system. Performs a function similar to the 
carriage return on a typewriter. Pressing it lets the computer know that 
you want to send data to the system’s memory. 

Home

 

Home 

Moves the cursor from the current position to the upper left corner of the 
screen. Data on the screen is not erased. This key will reset your SOM 
(Start of Message). You may use it to return the cursor to the top of the 
screen after entering data or requesting information from the system. 

ESC
Reset

 

Escape 

Returns the cursor to the left margin of the screen, one line at a time, 
without erasing the previous line. This key will reset your SOM to the 
beginning of the next line on your screen. If you have begun an entry 
that you do not want to complete, you may use this key to disregard the 
current entry and begin a new one. 

PgDn
Reset

 

Reset 

If the “Sabre Keyboard” mode (under the Options menu) is active, this 
key may also be used as a Reset key. 

PgUp
ReEnt

 

ReEnt 

Allows you to input a previously entered format without retyping all of 
the data. After making a correction to a format, moving the cursor to the 
end of a long entry before pressing Enter can be tiresome. The ReEnter 
key moves the cursor quickly to the end of the entry and resends it to 
the system. 
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Often it is more convenient to make a small change to an entry, rather than retyping 
an entire format. Some keys allow you to correct typing errors before sending your 
entries to the system. 

Editing keys 

You may also use these keys to correct some previously entered formats. Then after 
making a correction to a format, you may use the ReEnt (ReEnter) key to move the 
cursor to the end of the entry and resend it to the system. 

Once again, the location of these keys may be different on the keyboards in your 
office, but the functions of the keys are the same. 

• Left and Right arrow keys:  May be used to move forward and backward 
through a format to position the cursor and type over mistakes. 

Caution: Though the Up and Down arrow keys can be used to move the cursor, 
the system cannot read the starting point if these keys are used. Use the 
Reset key to make sure the system knows where the entry begins. 

• Insert and Delete keys:  May be used to insert and delete characters in a format. 
Often used in conjunction with the Left and Right arrow keys to insert or delete 
characters after moving forward or backward through a format. 

– Insert key Makes room for one more character and pushes the 
   remaining characters to the right. 

– Delete key Removes the character at the cursor and pulls the remaining 
   characters to the left. 

• Erase key:  Erases the character to the left of the cursor each time it is pressed. 

 
Some keys perform the functions described in the previous sections only when the 
“Sabre Keyboard” mode is active. If the “Windows Keyboard” option is active, some 
keys function as they do in other Windows applications. 

Keyboard 
mode for keys 

To verify the active keyboard mode, click “Options” in the menu bar. The keyboard 
option that is preceded by a checkmark is the active option. 
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S i g n i n g  i n t o  t h e  S a b r e  S y s t e m  

Employee Profile Records (EPRs) are an element of the Sabre system’s security, 
since they govern the capabilities of agents using the Sabre system. Specified 
individuals in your office will be responsible for creating and maintaining the 
Employee Profile Records for all agents in the office. 

Your EPR enables you to sign into the Sabre system and controls which functions 
you can or cannot perform in the system. 

The agent identification number that you will use to sign into the Sabre system is 
assigned by your agency and stored in your EPR. You will select your own passcode, 
in accordance with the passcode guidelines. 

 
The Sabre system has six work areas, identified as A, B, C, D, E, and F. By entering 
an asterisk (*) prior to your identification number when you sign in, you are signing 
into all six system work areas. 

Sign in 

Step Description Format Example 

1 Type SI* followed by your agent identification 
number 

SI*(identification number) 

SI*941032 

2 Type your passcode in the sign-in mask (passcode) 

TEXT01 
 

Response to 
step 1 

AGENT SIGN IN                                       
                                                    
   CURRENT PASSCODE            ID  <941032>     SUF  <B4T0> 
                                                     
   DUTY CODE    <*>   AREA   <*>      NEW PASSCODE          

Component Description 

CURRENT PASSCODE An area where you type your current passcode (passcode 
will not appear when typed) 

ID Reflects your agent identification number 

SUF Reflects your agency pseudo city code (PCC) 

DUTY CODE Reflects duty code or level of access 

AREA Reflects the area to be signed in 

NEW PASSCODE An area where you can change your passcode 
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B4T0.B4T0*ALJ...A.B.C.D.E.F Response to 
step 2 19JUN                                                         

**   SABRE EXCLUSIVES *SA* LOWEST AVAILABLE HOTEL RATES  **   
    2-5 STAR HOTELS 10PCT COMM GUARANTEED WITHIN 2 WEEKS      
**  INTER-CONTINENTAL- *THE WHOLE WORLD-HALF OFF* SUMMER  **  
   SALE INCL BKFAST AT PARTICIPATING HOTELS -HODIC/HOT        
 

The sign-in response includes: 

• Your agency’s pseudo city code 

• Your duty code 

• Your individual agent sign, which is 

– assigned by your agency 

– stored in your EPR 

– your signature in the Sabre system 

• The work areas signed in 

– The active area is shown first. 

– The system has placed you in work area A to begin. 

• Current date 

• Sign-in message 

– Messages may be created by the Sabre system or your local agency. 

– May be redisplayed after the sign-in response has been cleared from screen. 

 
Use these guidelines in selecting your personal passcode: Passcode 

guidelines • Passcode must be six to eight alpha/numeric characters (at least one alpha 
character and at least one numeric character). 

• The letters Q and Z are not valid. 

• Cannot use the same character more than twice in succession. 

• Do not use the word “Sabre”. 
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Duty codes are system access rights that determine the range of functions that an 
agent can perform in the Sabre system. These are stored in your EPR and vary 
according to an agent’s duties. 

Duty codes 

If your EPR allows it, you can also switch duty codes, when necessary, in order to 
perform different functions. 

The four duty codes, along with the access rights provided by each, are shown below. 

Duty Code Description 

* Allows agent full reservations access for normal Sabre system activity 

9 Allows agent supervisory and managerial access for those responsible for 
management functions 

6 Allows agent to access the training mode, providing the ability to practice 
without impacting actual customer records 

/ Allows agent to access Sabre Assisted Instructions self-paced lessons 
(S.A.I.) 
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W o r k  A r e a s  

When you leave a work area, it becomes inactive until you return to it. Entries made 
in the active area do not affect the work you do in another area. When you return to 
an area you previously left, that area becomes active again. 

Note: All items to be recorded in a single Passenger Name Record (PNR) should 
be completed in the same work area. 

Task Format 

Change to a different work area: 

A, B, C, D, E, or F 

⌧(work area letter) 

⌧D 

Display current work area *S 

Display the status of all work areas *S* 

Display the status of all work areas, along with assigned 
printers 

*S*P 

Redisplay the sign-in message S/* 
 

Change work area: Responses to 
entries  ⌧D 

 B4T0.B4T0*ALJ..D 

Display current work area: 

 *S 

 B4T0.B4T0*ALJ..D 

Display status of all work areas (check for activity): 

 *S* 

 B4T0.B4T0*ALJ.A..PNR PRESENT       
 ACTIVE AGENT – L  JONES  - 941032-B4T0 
 B4T0.B4T0*ALJ.B..PNR PRESENT       
 B4T0.B4T0*ALJ.C..PNR PRESENT       
 B4T0.B4T0*ALJ.D..                  
 B4T0.B4T0*ALJ.E..                  
 B4T0.B4T0*ALJ.F..                  
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Display status of work areas and assigned printers: 

 *S*P 

 B4T0.B4T0*ALJ.A..PNR PRESENT 
 ACTIVE AGENT – L  JONES  - 941032-B4T0 
 H1-EB0414 AT T-EB133E I-EB0412 
 B4T0.B4T0*ALJ.B 
 H1-EB0414 AT T-EB133E I-EB0412 
 B4T0.B4T0*ALJ.C 
 NO PRINTERS 
 B4T0.B4T0*ALJ.D 
 NO PRINTERS 
 B4T0.B4T0*ALJ.E 
 NO PRINTERS 
 B4T0.B4T0*ALJ.F 
 NO PRINTERS 

Redisplay sign-in message: 

 S/* 

 B4T0.B4T0*ALJ..B..PNR PRESENT                             
 19JUN                                                         
 **   SABRE EXCLUSIVES *SA* LOWEST AVAILABLE HOTEL RATES  **   
     2-5 STAR HOTELS 10PCT COMM GUARANTEED WITHIN 2 WEEKS      
 **  INTER-CONTINENTAL- *THE WHOLE WORLD-HALF OFF* SUMMER  **  
    SALE INCL BKFAST AT PARTICIPATING HOTELS -HODIC/HOT        
 

 

 

Working in the Sabre System Student Guide    June 2002 Work Areas    12 



U s i n g  t h e  M e m o  A r e a  

The Memo Area provides a section of the Sabre window where you can temporarily 
place information for viewing. It eliminates the need for manually taking notes while 
talking with your client, since you can use the Memo Area as a note pad to record 
pieces of information that may be needed later in making a reservation. It may be 
especially helpful when you have information that is needed in multiple reservations. 
The Memo Area is not an active work area in the system and is used only to store 
information. Text in the Memo Area of the screen will not inhibit any functionality. 

 
The Memo Area option on the “View” menu toggles the Memo Area between being 
visible and not visible. Active options are indicated by a checkmark immediately 
preceding the item. Therefore, when “Memo Area” is preceded by a checkmark, it is 
active and will be visible. You can still send information to the Memo Area even 
when it is not visible. Then when the Memo Area is active, you will see the 
information you stored there earlier. 

Memo Area 
option 

 
Follow these steps to display the Memo Area. You may use either the mouse or the 
keyboard action shown. 

Display the 
Memo Area 

1. Display the “View” menu 

– mouse:  Click the View drop-down menu 

– keyboard: Press Alt+V 

2. Select the Memo Area option 

– mouse:  Click Memo Area 

– keyboard: Press M 

 
The Memo Area appears close to the top of the Sabre window just below the menu 
bar. Follow these steps to place text in the Memo Area: 

Placing text in 
the Memo 
Area 1. Type the text in the Sabre window. 

2. Press the Memo (End) key to place text in the Memo Area. 

End
MEMO

 

A scroll bar, which appears at the right of the Memo Area, allows you to scroll 
through the information you have placed in this area. 

Information will remain in the Sabre window until it is removed. Clearing the Sabre 
window does not erase text from the Memo Area. 

 
You may erase information stored in the Memo Area when it is no longer needed. Erase Memo 

Area To erase the text from the Memo Area, press Alt+Memo (Alt+End) 
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S i g n i n g  o u t  o f  t h e  S a b r e  S y s t e m  

The Sabre system tracks all entries by agent sign. When you are through working in 
the system, you should sign out to prevent other individuals from making entries 
using your passcode. 

Description Format 

Sign out of the current work area SO 

Sign out of all work areas SO* 
 

Sign out of current work area: Responses 

 SO 

 B SIGNED OUT 

Sign out of all work areas: 

 SO* 

 A.B.C.D.E.F..SIGNED OUT 
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F o r m a t  F i n d e r  H e l p  S y s t e m  

The Format FinderSM  help system displays Sabre system formats and procedures. It 
incorporates all Fox online help content and is available on the Internet and from 
your desktop. If you are using eVoyaSM Webtop or Sabre® for Windows® reservations 
software, launch the Format Finder feature by pressing Ctrl+Z; if you are accessing 
the help system from the Agency eServices web site, under the Support tab, click 
“Online w/Format Finder.” 

You can find the desired information in the Format Finder feature by using the Table 
of Contents, Index, or Search. The following table suggests the most efficient ways 
to access the relevant information in the Format Finder feature. 

Most of the topics in this curriculum are located in the Format Finder feature on the 
main Table of Contents under the book EPR – Employee Profile Records (unless 
noted below). 

Curriculum 
Topic 

Table of 
Contents 

Sub-Book in the 
Table of 
Contents 

Index or 
Search 

Identification Code 
Keys 

Glossary G’s–J’s Identification Code 
Keys 

Equipment Glossary G’s–J’s Hardware 

Employee Profile 
Record (EPR) 

 Overview – 
Employee Profile 
Records 

EPR 

Agent ID  Overview – 
Employee Profile 
Records 

Agent ID 

Duty Codes  Overview – 
Employee Profile 
Records 

Duty Codes 

Passcode  Overview – 
Employee Profile 
Records 

Passcode 

Sign in  Sign into Sabre Sign into 

Change areas  Sign into Sabre Change Sabre 
Work Areas 

Sign out  Sign into Sabre Sign out 
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O t h e r  R e f e r e n c e s  

Format Quick References may be found on the Web at http://eservices.sabre.com/ 
under the Training menu. 

Additional training and references may be found in Personal TrainerSM education 
software. Personal Trainer is available on the Web at http://eservices.sabre.com/ 
under the Training menu. 

 
Please call the software or hardware help desks only after you have tried to find the 
answers to your questions or problems through the use of the Sabre system 
references or any other appropriate resources. 

Help Desk 
assistance 

Hardware Help Desk  Actual physical equipment problems 

    800-331-7260        or        QP/DSCG 

Software Help Desk  Functional and format questions 

    817-355-7420        or        QP/FSGG 
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Q u i c k  R e f e r e n c e  

Signing into the Sabre System 

Step 1 – Enter your agent identification number SI*941032 

Step 2 – Enter your passcode TEXT01 

Display your workstation’s terminal address ‡J 

Work Areas 

Change to a different work area ⌧D 

Display the current work area *S 

Display the status of all work areas *S* 

Display the status of all work areas and assigned printers *S*P 

Redisplay the sign-in message S/* 

Signing out of the Sabre System 

Sign out of the current work area SO 

Sign out of all work areas SO* 

Using the Memo Area 

Display the Memo Area: 

 Step 1 – Display the View menu 

 Step 2 – Select the Memo Area option 

 

Click “View”                or     Press Alt+V 

Click “Memo Area”     or     Press M 

Place text in Memo Area Type text; then press Memo (End) 

Erase text in Memo Area Press Alt+Memo (Alt+End) 
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R e v i e w  

Name:  __________________________________________________________ 
Pseudo City Code: __________________________________________________ 
Training Event:  ___________________________________________________ 
Date:  ___________________________________________________________ 

Please circle the correct answer(s): 

Which entry represents the first step of signing into the Sabre system? 
A.  SO*423598 
B.  S/*423598 
C.  SI*423598 
D.  *S423598 

1. 

2. 

3. 

4. 

5. 

6. 

Which of the following represents an acceptable passcode for signing into the 
Sabre system? 
A.  RED24KC 
B.  RED2 
C.  REDHOT 
D.  REDDD24K 

Which duty code is used by most agents and allows full reservations access for 
normal system activity? 
A.  9 
B.  6 
C.  / 
D.  * 

Which key is used prior to the letter “B” to indicate that you want to move to that 
work area? 
A.  Change key 
B.  Erase key 
C.  Cross of Lorraine key 
D.  Home key 

Which entry displays the work area currently being used? 
A.  *W 
B.  *S 
C.  *J 
D.  *A 

Which key or key combination is used to place text in the Memo Area? 
A.  Alt+Memo (End) key 
B.  Enter key 
C.  Escape key 
D.  Memo (End) key 
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7. 

8. 

9. 

10. 

Which key allows you to string several entries together and enter them 
simultaneously? 
A.  Right Arrow key 
B.  Cross of Lorraine key 
C.  End-Item key 
D.  Enter key 

Which entry signs you out of all areas in the Sabre system? 
A.  SO 
B.  SOALL 
C.  SO* 
D.  SO*ALL 

Which identification code key allows you to request flight availability? 
A.  * key 
B.  1 key 
C.  4 key 
D.  2 key 

Which key transmits information to the Sabre system? 
A.  Reset key 
B.  Clear key 
C.  Ctrl key 
D.  Enter key 
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